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Introduction 

HPV WEB/SERVER 2007 SP2 is a scalable and robust solution for viewing MPP 
files in a corporate environment. The HPV Web/Server 2007 SP2 application 
supports a wide range of users and is designed to support the Microsoft® Project 
viewing (MPP files) needs of the entire project team or organization:  
 

1. Project Team members can view project information right from their 
desktop using any standard browser.  

2. Project Managers can easily publish or email project information and make it available in a matter 
of seconds to the entire project team.   

3. Executives can view project plans and get quick access to project reports, status reports and 
other critical information. 

 
Supported files format version 
The following files are supported by HPV Web/ Server 2007 SP2: Microsoft Project files ’98, Microsoft 
Project files 2000, Microsoft Project files 2002; Microsoft Project files 2003; Microsoft Project files 2007. 
 
 





 

End-User License Agreement 

1. License.  A.  Subject to all of the terms and conditions hereof, Viewer Central, 
Inc. (the "Licensor") hereby GRANTS to the end-user (the "Licensee") a non-
transferable License to use the software program entitled HPV Web/Server 2007 
SP2 (the "Viewer"), in object code, for five years (the "Term"), terminable as 
specified herein, which Licensee hereby accepts (the "License").  Licensor may 
assign its rights under this Agreement, and delegate its duties hereunder, to any 

of its affiliates.  Licensee acknowledges that it has no right to modify the Viewer without Licensor's prior 
written consent. 
 
2. Location and Use of Software.  The Viewer shall be used by Licensee only on one computer (per seat 
license).  The Viewer shall be used only for the conduct and operation of Licensee's own business, for the 
benefit of Licensee and its customers.  Licensee shall under no circumstances assign or attempt to 
sublicense the License to any other person, and any attempt to do so would constitute a material breach 
of this Agreement.   
 
3. Copies.  No copying of the Viewer is permitted except for one back-up copy. 
 
4. Consideration.  The royalties for this License are set forth in the check-out cart on the site. 
 
5. Non-Disclosure, Confidentiality.  A.  The Viewer, and any future permitted modifications, changes, 
enhancements, upgrades, revisions, or additions made to the Viewer, whether made or installed Licensor, 
Licensee, or a third party, are and shall be the sole and exclusive property of Licensor, including all 
applicable Intellectual Property rights inherent therein and appurtenant thereto.  Licensee shall not sell, 
transfer, publish, disclose, display or otherwise make available to others any source code or object code, 
documentation, or other material relating to the Viewer.  Licensee shall assist Licensor in identifying and 
preventing any use or disclosure of the source code or object code of the Viewer, or of any portion 
thereof, or any of the algorithms or logic contained therein.  Without limitation of the foregoing, Licensee 
shall notify Licensor immediately if Licensee learns or has reason to believe that any person has violated, 
or intends to violate, the terms of this Agreement, or, if not bound thereby, intends to infringe upon or 
dilute Licensor's Intellectual Property in any way whatsoever; and Licensee will cooperate with Licensor in 
seeking injunctive or other equitable relief in the name of Licensee or of Licensor against any such person. 
 
B. Licensee hereby acknowledges that the Viewer contains proprietary Intellectual Property of Licensor, 
and agrees to maintain the confidentiality of the Viewer in a manner using at least as great a degree of 
care as the manner used to maintain the confidentiality of Licensee's own most secret and valuable 
information.  Licensee hereby acknowledges that the disclosure by Licensee or any of its employees or 
agents of any aspect or portion of the Viewer, or any of the confidential information referred to herein or 
any other information which ought to remain confidential, would give rise to irreparable injury to Licensor, 
which is inadequately compensable in damages.  Accordingly, in order to prevent any disclosure or dilution 
of Licensor's Intellectual Property, Licensor may seek or obtain emergency injunctive relief. 
 
C. All of the undertakings and obligations relating to confidentiality and non-disclosure, whether contained 
in this paragraph or elsewhere in this Agreement, and whether of Licensor or of Licensee, shall survive the 
termination of this Agreement for any reason whatsoever. 
 
6. Warranty.  Licensor warrants that the Viewer is operational and substantially free of material defects. 
 Licensor disclaims any other warranties, including any warranties that might otherwise be implied at law, 
such as the implied warranties of merchantability or of fitness for a particular purpose. 
THE WARRANTY STATED ABOVE IS A LIMITED WARRANTY, AND IS THE ONLY WARRANTY MADE BY 
LICENSOR TO LICENSEE.  LICENSOR DISCLAIMS, AND LICENSEE HEREBY EXPRESSLY WAIVES, ANY 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED.  LICENSOR SHALL HAVE NO LIABILITY WITH 
RESPECT TO ITS OBLIGATIONS UNDER THIS AGREEMENT, OR OTHERWISE, FOR ANY EXEMPLARY, 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR PUNITIVE DAMAGES, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  THE ABOVE-STATED EXPRESS WARRANTY IS IN LIEU OF ALL OTHER 
LIABILITIES OR OBLIGATIONS OF LICENSOR FOR DAMAGES THAT MIGHT ARISE OUT OF, OR IN 
CONNECTION WITH, THE DEVELOPMENT, USE, OR PERFORMANCE OF THE VIEWER. 
 
7. Termination.  This Agreement shall terminate at the end of the Term, unless the Parties agree to 
extend this Agreement, or either party has previously terminated the Agreement for breach.  Any 
termination of this Agreement shall automatically, and without any further action by Licensor, terminate 
and extinguish the License, whereupon, Licensor shall have the right to take immediate possession of the 
Viewer, and all copies thereof, wheresoever located, and all documentation thereto, without notice or 
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demand.  Notwithstanding the foregoing, all provisions hereof relating to confidentiality of the Viewer and 
dispute resolution shall survive the termination of this Agreement. 
 
8. Taxes.  Licensee shall pay all taxes, whether national or local, howsoever designated, which are levied 
or imposed by reason of the transaction and future transactions contemplated hereby. 
 
9. Binding Effect.  This Agreement shall inure to the benefit of, and shall be binding upon, each of the 
parties hereto, their respective heirs, personal representatives, administrators, successors and assigns. 
 
10. Choice of Law.  The validity, interpretation, and enforcement of this Agreement, and all other 
instruments and documents executed in connection with this transaction, shall be governed by the laws of 
the Commonwealth of Massachusetts, excluding those laws relating to the resolution of conflicts between 
laws of different jurisdictions.  Licensee hereby waives, in the case of any such action or proceeding 
brought in state or federal courts in the Commonwealth of Massachusetts, defenses based on venue, 
jurisdiction, or forum non conveniens.  All parties waive any right to raise, as a defense or otherwise, 
conflict of laws issues to challenge the governing law identified in this Agreement. 
 
11. Interpretation and Rules of Construction; Definitions.  The section and subsection headings and 
captions contained in this Agreement are for reference purposes only, and shall not affect in any way the 
meaning or interpretation of this Agreement.  Whenever the context shall require, all words herein in the 
masculine gender shall be deemed to include the feminine or neuter genders, all singular words shall 
include the plural, and plural words shall include the singular.  The use of the word "person" shall refer to 
all legal persons, whether natural or created by statute or other legal process including, but not limited to, 
any individual, corporation, partnership, association, joint-stock company, trust, limitada, limited liability 
company or partnership, unincorporated organization, or joint venture.  The term "source code" means 
such written rendition of software programs readable and comprehensible by humans, and the term 
"object code" means such rendition and compilation of software programs primarily readable by machines. 
 The term "Intellectual Property" shall include material protected by copyright, trademark, servicemark, 
trade secrets and know-how, and design and patent rights.  Any term herein that appears to be used as a 
defined term, but whose definition is missing from this Agreement, shall be defined in accordance with the 
definitions in any of the related documents or schedules attached hereto. 
 
12. Severability.  If any provision of this Agreement should be determined by a court of competent 
jurisdiction to be invalid, illegal or unenforceable, then that determination will not affect or impair the 
validity, legality, or enforceability of the remaining provisions contained herein. 
 
13. Attorneys' Fees.  If any legal proceeding is brought by a party to this Agreement to enforce its 
provisions, or to seek remedy for any breach hereof, then the prevailing party shall be entitled to receive 
its reasonable attorneys' fees and costs incurred in connection with that legal proceeding (including any 
appellate proceedings) from the other party. 



 

What is New in this Version 

64 bit support 
HPV Web/Server 2007 SP2 is designed to run natively on 64 bit IIS mode.  
 
Browsers compatibility 
All major browsers are now fully supported including Internet Explorer, Mozilla 
Firefox and Apple Safari.  
 
Hyperlinks 
HPV Web/Server 2007 SP2 support displaying of hyperlinks in project files. 
 
Information 
Now HPV Web/Server 2007 SP2 offer the possibility to view extended information about project, tasks, 
resources and assignments. 
 
Options 
All options are now available at one place including several new options and date format enhancements. 
 
Custom fields 
Custom fields data and lookup values are now displayed on all project formats. 
 
Go To 
Go To menu option is now available. 
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Minimum System Requirements 

The Operating System requirements are kept at minimum. The client workstation 
needs to run on a platform that supports one of the following browsers:  

1. Internet Explorer 6.0 and higher  
2. Netscape 7.1 and higher  

 
Most of the data processing occurs on the server so the impact on local hardware 
performance (memory, processor, hard disk space) is minimum. The following platforms were tested and 
certified for HPV client usage:  

o Windows 9x, Windows 2000, Windows XP, Windows 2003 and Mac Os 
 
The recommended system configuration to use HPV Web Server is Microsoft Windows® 2000,  Windows 
XP® or Windows 2003 on a computer running with a Pentium IV 2.5 Ghz processor and 1 Gb of RAM.  
 
The minimum requirements your computer needs to run HPV Web/Server are listed below:  
 

Server side 

Computer/Processor Computer with Pentium 2.5 Ghz or higher processor; Pentium IV 
recommended; 

Memory 512 MB of RAM (1 Gb recommended); 
Hard Disk 20MB  

Note: The C:\Program Files\Viewer Central Inc\HPV Web Server\Files\MPP\ 
folder is the location on your hard disk where files (such as: mpp, xml, ini or 
graphics) are stored as you view them. 

Operating System Windows NT 4.0 with Service Pack 6 (SP6) or later, Windows 2000, or Windows 
XP or later; 

Applications § IIS Server v5.0 or higher; 
§ .NET Framework 2.0; 

Display Super VGA (800 x 600) or higher-resolution monitor with 256 colors; 
Peripherals Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device. 

 

Client side 

Computer/Processor Computer with Pentium 133 megahertz (MHz) or higher processor; Pentium III 
recommended 

Memory 64 MB of RAM; 
Hard Disk 10MB; 
Operating System Windows 98, Windows 98 Second Edition, Windows Millennium Edition 

(Windows Me), Windows NT 4.0 with Service Pack 6 (SP6) or later, Windows 
2000, or Windows XP or later; 

Applications Internet Explorer 6.0 or higher; 
Display Super VGA (800 x 600) or higher-resolution monitor with 256 colors; 
Peripherals Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device. 
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Installation Guide 

In order to install HPV Web/Server 2007 SP2 you need to perform the following 
steps: 
 

1. Download the Installation Kit for HPV Web/Server 2007 SP2 (i.e. 
HPVWeb2007SP2_Trial_10.3.0_En.exe); 

2. Run the Installation Kit file (i.e. HPVWeb2007SP2_Trial_10.3.0_En.exe); 
3. Read the License Agreement and select Accept if you want to continue; 
4. Enter your User Name and Company to match yours; 
5. Select installation path and click Next; 
6. In the IIS Configuration Page you will be able to set the site where the HPV Web/Server 2007 

SP2 should be installed. Notice that in Windows XP and Windows 2000 Professional, you may only 
install the application in the Default Web Site as a Virtual Folder. Windows 2003 and Windows 
2000 Servers are also able to install the application as a Virtual Folder in an existing site, but 
they also have the possibility of installing it in the root of a New Web Site.  

7. Click Install and wait for setup to finalize settings; 
8. Click Finish to end the installation process. 
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General Features 

Navigating through the HPV Web/Server 2007 SP2 is easy and intuitive. There are 
certain features that you will find applicable in all views and which you can use to 
make your project content more readable. You can locate these features both in 
the Main Menu and in the Toolbar shortcuts. 
 

Print: Views: 
Print Preview Calendar 
Page Setup Gantt Chart 

 Network Diagram 
Format: Task Usage 

Timescale Tracking Gantt 
 Resource Graph 
Other: Resource Sheet 

Email Resource Usage 
View File  
Zoom Project: 
Go To Sort 
Indicators Filter 
Multilanguage support (English, French, 
German, Spanish, Italian) 

Task Notes 
Show outline level 

Subprojects Project Information 
Deadlines  
Links Edit: 
Bar Format Find 
Checking password for password 
protected files 

Hide column 
 

Tables: Open from: 
Predefined tables ODBC 
More tables MPP Folders Link 
Column Definition MSP Central Link 
Custom Tables View File (using resource...) 
Custom Fields  

 Print Engine: 
More Filters: Print 

Custom Filters Send by email (as PDF) 
Highlight Filters  

 More Views: 
Administration Page Custom Views 

Automatically open subprojects Bar Rollup 
Intelligent 30 engine Descriptive Network Diagram 

 Detail Gantt 
Appearance & Styles Leveling Gantt 
 Milestone Dates Rollup 
Adjust columns width Milestone Rollup 
 Multiple Baselines Gantt 
Insert: Task Sheet 

Column 
 
 
 
 
 
 
 
 





 

How to configure HPV Web/Server 

HPV Web/Server 2007 SP2 is easily configurable from the Administration page 
that can be accessed at the location: http://ServerName/HPVWeb/Admin/. The 
Administration page is split in eight tabs as follows: 
 

General - In this tab you may configure: 

o Automatically Load Subproject Files 
 
If this option is checked, the subproject files will be loaded without user interaction when master 
project is loaded. For this, the subprojects files must be already uploaded on server from a 
previous visualization and the master project must be opened by accessing the link from previous 
visualization.  
 
For example, the master project is opened, uploaded on server with master_1.mpp name, then 
the subprojects are opened and uploaded with s1_1.mpp, s2_1.mpp, s3_1.mpp. In order to 
automatically upload subprojects, the master project must be accessed by the following link: 
http://HPVWeb/Views.aspx?mppfile=master_1.mpp 
  

o Use Print Optimization 
 
Allows to generate for print only a number of pages set by Default Print Pages setting. In order to 
increase speed for printing, a number of pages will initially be printed. If option is unchecked, all 
pages are selected.  
This option is checked by default. 
  

o Maximum Concurrent Print Jobs 
 
Maximum Print jobs that are handled at one time by HPV Web/Server 2007 SP2 Print engine. For 
better performance, this setting is set to 2 by default. 
  

o Default Pages per Print Job 
 
Maximum number of pages printed by default when Use Print Optimization option is checked. 
  

o Company Header 
 
The text set here will appear in header section of the printed page, above the header from 
project file. This can be used in order to identify documents printed by HPV Web/Server 2007 
SP2.  
By default is empty and no additional text will appear on header. 
  

o Company Footer 
 
The text set here will appear in footer section of the printed page, above the footer from project 
file. This can be used in order to identify documents printed by HPV Web/Server 2007 SP2.  
By default is empty and no additional text will appear on footer. 
  

o Session Use Timeout 
 
Use Session Timeout to expire session after a period of time. This option will enable/disable the 
Session Timeout feature specific to browsers. If checked, after a period of inactivity in browser 
window, the server will terminate session to avoid misusage. 
  

o Session Timeout  
 
Sets the number of minutes in which the session will expire. After the set number of inactivity 
minutes on HPV Web/Server 2007 SP2 application browser window, the session will expire and 
the project viewed will not be available anymore.  
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By default is set to 30 minutes. 
  

o Application URL 
 
Sets the URL property to point to your website, machine name or IP address. The URL entered 
here represents the actual URL of the HPV Web/Server 2007 SP2 application. This will be entered 
automatically after installing and will be checked to correspond with the actual URL. Not setting 
this correctly may generate errors related to files location on server. 
  

o Exit redirect 
 
URL that will be redirected to when clicking on Exit link from HPV Web/Server 2007 SP2 
application. It can be the company website or a ”r;Thank You” page (thanks.aspx) 
  

 

View - In this tab you may configure: 

o Use Pagination 
 
Split tasks and resources in pages for fast display. This option is recommended for large projects 
where it can task a while to load all the tasks or resources from a view. If this option is checked, 
tasks and resources will be split in pages for fast display in browser and only one page will be 
displayed at one moment. Navigation through pages can be done from ”r;GoTo” menu or toolbar 
button, where a list of pages will appear and you can select the one you want to display. This 
split in pages will have effect only on view in browser, in print, page setup will be applied. 
  

o Maximum tasks displayed per page 
 
Number of tasks to be displayed in one page. If Use Pagination option is enabled, this setting will 
set how many tasks will be displayed in one page. Recommended value is around 100, but the 
value can be adjusted accordingly to server capabilities or desired visualization speed correlated 
to number of displayed tasks 
  

o Maximum resources displayed per page 
 
Number of resources to be displayed in one page. If Use Pagination option is enabled, this setting 
will set how many resources will be displayed in one page. Recommended value is around 100, 
but the value can be adjusted accordingly to server capabilities or desired visualization speed 
correlated to number of displayed resources 
  

o Show Bar Format 
 
Yes/No option to display bar format. BarFormat set to enabled results in a (tracking) Gantt view 
that is very similar to the way Ms Project looks like. This causes a decrease in speed. BarFormat 
set to disabled results in a (tracking) Gantt view where all the tasks are drawn using the Ms 
Project bar format defaults. The speed is noticeably better. 
  

o Show Title 
 
Yes/No option to display the Project title on top. If this option is checked, the Project title appears 
on top of HPV Web/Server 2007 SP2, above the menu and toolbar. This option is checked by 
default. 
  

o Show Menu 
 
Yes/No option to display the HPV Web/Server 2007 SP2 Menu. If this option is unchecked, the 
application menu will not be displayed. Since the menu options are available also on toolbar, this 
option can be taken into consideration to maximize the project display area. This option is 
checked by default. 
  

o Show Toolbar 
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Yes/No option to display the HPV Web/Server 2007 SP2 Toolbar. If this option is unchecked, the 
application toolbars will not be displayed. Since the toolbar options are available also on menu, 
this option can be taken into consideration to maximize the project display area. This option is 
checked by default. 
  

o Show Viewbar 
 
Yes/No option to display the HPV Web/Server 2007 SP2 Viewbar. If this option is unchecked, the 
Viewbar (the window on left containing views icons) will not be displayed. Since the Views are 
available also on View menu, this option can be taken into consideration to maximize the project 
display area. This option is checked by default. 
  

o Merge Resources 
 
This setting is telling Resource Usage View whether to merge the Resources with the same name. 
If this option is checked, the resources with the same name are displayed as one, with cumulated 
values. 
  

o Number Of Weeks Displayed 
 
The number of detail weeks displayed in Resource Usage - value may range between 1 and 4. 
Navigation through weeks displayed is made through horizontal scrollbar and through set of 
weeks by links displayed above the view. By default this setting is set to 2 weeks. 
  

o Display Current Date Week 
 
This Yes/No setting is telling Resource Usage View whether to display the current server date 
week for details. If this option is checked, when opening the Resource Usage view the current 
server week will be displayed. If this option is unchecked, the first week of the project is 
displayed. This option is unchecked by default. 
  

o Show Unassigned Filter Resource Name 
 
This setting is telling Resource Usage View whether to display or not the Unassigned groups when 
using FilterResourceName parameter. If this option is checked, when filtering in Resource Usage 
view, the Unassigned groups will appear also. This option is checked by default. 
  

o Use Hierarchical Display 
 
This setting is telling Resource Usage View whether to use or not hierarchical display for tasks. 
The hierarchical display for tasks means that tasks displayed for a resource will be structured as 
in task view, with summaries. 
  

Email - In this tab you may configure Email settings  

The email settings are used by the Send by email engine. To use this service you have to enter both SMTP 
Server (i.e. smtp.company.com) and Sender Address (i.e. user@company.com); 

The email body represent the content of the email on which to attach the PDF document. 
 
  

Menus - In this tab you may configure which menus are available to the users. Notice that the menus 
marked as Hide will be actually disabled. 

 

Appearance - In this tab you may configure: 

o Default Language  
 
The administrator may set the default language that the application will use to display the 
information. The users will be able to change this setting independently within HPV Web/Server 
2007 SP2 Application from the Select Language menu. 
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o Theme  
 
The administrator may set the default theme that the application will use; the users will be able 
to change this setting independently within HPV Web/Server 2007 SP2 Application from the 
Format/Appearance menu. 
  

o Show link on top  
 
The administrator may set whether the current link is displayed or not on top of the application. 

 

MPP Folders Path - In this tab you may configure the shared folders that the users may access to open 
MPP files. You may add several types of location, but always include full path to the folder you want to 
share to your users. Several examples are: 

C:\MyPath\MPPFiles 

\\SERVER\C\MyPath\MPPFiles 

file://C:/MyPath/MPPFiles 

Notice however that trying to share a folder from another computer requires authentication. To set up 
proper rights for the HPV Web/Server 2007 SP2 application so it will be able to access the folders and files 
from another computer, you have to modify in your Web.Config file the identity attribute from: 

<identity impersonate="false" /> 

to: 

<identity impersonate="true" userName="youruser" password="yourpassword" /> 

   

ODBC - HPV Web/Server 2007 SP2 Application is able to open any Data Source Name that points to valid 
Project Repository Databases. A valid Project Repository Database is a database created from within 
Microsoft Project, by using the Save in ODBC functionality. In this tab you may configure which System 
DSN should be available to the users. Click on Display only allowed System DSN and then use Show/Hide 
options to move the DSN from one section to the other. In this way, the administrator may allow access 
only to those DSN specified in this page. 

 

SharePoint  

This SharePoint user needs minimum "Reader" rights to the SharePoint websites and full control rights to 
the following two folders: \\Program Files\Viewer Central Inc.\HPV Web Server 2007 SP2 and 
\\Windows\Microsoft.Net The SharePoint user added at this step allows full integration between the HPV 
Web viewer and your SharePoint websites that contains the MS Project document library files. This user 
will "ask" SharePoint in behalf of HPV Web viewer for SharePoint "Reader" access to the SharePoint site. 
To complete the SharePoint integration you need to import the HPV Web Part into your SharePoint sites. 
In order to do that you should follow the step by step HPV Web Part configuration from the HPV Web 
Server 2007 SP2 Product guide document. Click "?" for troubleshooting and manual setup info. 

 Troubleshooting 

 If you receive an error when you try to add the SharePoint user name and password you need to follow 
these manual steps: 

1. Open in Notepad \Program Files\Viewer Central Inc\HPV Web Server 2007 SP2\Web.config file 

2. Locate the <impersonate> line 

3. Add/edit the following information: 

impersonate= "true" userName=”your user” password=”your password” 

4. Make sure the above user has ”r;reader” rights in your SharePoint sites and full control rights to the 
following folders on your server: 

Program Files \ Viewer Central Inc \ HPV Web Server 2007 SP2 and Windows \ Microsoft.Net \ Framework 

 

For more information download the HPV Web Server 2007 SP2 product guide from our support website 
section at www.projectviewercentral.com 
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How to view a file using HPV Web/Server 

Generally, in HPV Web/Server 2007 SP2 application, you have to upload a file 
on a server before you can view it. In order to help project managers who update 
very often their project files, we have added new methods of viewing the files. 
Therefore, you may use one of the following methods to view a MPP File: 
 
Standard Open Method: Click on the Browse button located either in the default 
page of HPV Web Server or in the File/Open form, select the MPP file you want to upload and then click on 
View project to load the file in HPV Web/Server.  
 
Open Subprojects: If your MPP file contains subprojects, click on the (+) sign corresponding to each 
subproject to upload them. Notice that, in the standard opening method, you will be asked to provide the 
path to the location of the MPP File. If you want to simplify the process and not be asked to locate the 
subproject each time you upload it, please relate to Method 1 from Browser Address Link Methods: copy 
both the main project (i.e. sample.mpp) and its subprojects in the C:\Program Files\Viewer Central 
Inc\HPV Web Server 2007 SP2\Files\MPP\ folder (or the appropriate location on your server where HPV 
Web Server is installed), open Internet Explorer (or other compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp, then click on the (+) sign corresponding to 
each subproject. The subproject will be instantly viewed.  
 
Browser Address Link Methods: 
 
· Method 1: Copy the file you wish to view and update often (i.e. sample.mpp) in the C:\Program 
Files\Viewer Central Inc\HPV Web Server 2007 SP2\Files\MPP\ folder (or the appropriate location on your 
server where HPV Web Server is installed). Open Internet Explorer (or other compatible browser) and type 
the address: http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp. This will automatically view the 
file.  
 
· Method 2: Create the folders ProjectManager1 and ProjectManager2 in the C:\Program Files\Viewer 
Central Inc\HPV Web Server 2007 SP2\Files\MPP\ folder. Copy the files you wish to view and update often 
(i.e. sample.mpp) according to each Project Manager into the C:\Program Files\Viewer Central Inc\HPV 
Web Server 2007 SP2\Files\MPP\ProjectManager1\ or C:\Program Files\Viewer Central Inc\HPV Web 
Server 2007 SP2\Files\MPP\ProjectyManager2\ folder (or the appropriate location on your server where 
HPV Web Server is installed). Open Internet Explorer (or other compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=ProjectManager1/sample.mpp. This will automatically view 
the file.  
 
· Method 3: If the file is situated on the same server or on a network path and you don't wish to move it 
into the MPP Folder, you may alternatively create a Virtual Folder in the MPP Folder in IIS, pointing to the 
file path folder (i.e. if you have the network path X:\MPPFiles\sample.mpp, you will create the Virtual 
Folder MPPFiles in /HPVWeb/Files/Mpp/ folder). Open Internet Explorer (or other compatible browser) and 
type the address: http://localhost/HPVWeb/Views.aspx?mppfile=/MPPFiles/sample.mpp. This will 
automatically view the file. 
 
· Method 4: If the file you wish to view is situated on another Internet server (i.e. 
http://www.myserver.com/files/sample.mpp) you are still able to view this file directly by opening 
Internet Explorer (or other compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=http://www.myserver.com/files/sample.mpp. This will 
automatically view the file.  
 
Alternative Browser Address Link Method (using resource...) 
These methods can be used if you want to view a file filtered directly by a resource name (i.e. John 
Smith). These methods are particularly important because the users are able to view only the tasks 
assigned to them within a project and then, bookmark the page for further references. 
 

 Copy the file you wish to view and update often (i.e. sample.mpp) in the C:\Program Files\Viewer 
Central Inc\HPV Web Server 2007 SP2\Files\MPP\ folder (or the appropriate location on your 
server where HPV Web Server is installed). Open Internet Explorer (or other compatible browser) 
and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp&filterresourcename=JohnSmith. The 
project file will be opened filtered directly by Using resource John Smith. 

or 
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 Create the folders ProjectManager1 and ProjectManager2 in the C:\Program Files\Viewer Central 
Inc\HPV Web Server 2007 SP2\Files\MPP\ folder. Copy the files you wish to view and update 
often (i.e. sample.mpp) according to each Project Manager into the C:\Program Files\Viewer 
Central Inc\HPV Web Server 2007 SP2\Files\MPP\ProjectManager1\ or C:\Program Files\Viewer 
Central Inc\HPV Web Server 2007 SP2\Files\MPP\ProjectyManager2\ folder (or the appropriate 
location on your server where HPV Web Server is installed). Open Internet Explorer (or other 
compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=ProjectManager1/sample.mpp&filteresourcename=
JohnSmith. 

or 
 If the file is situated on the same server or on a network path and you don't wish to move it into 

the MPP Folder, you may alternatively create a Virtual Folder in the MPP Folder in IIS, pointing to 
the file path folder (i.e. if you have the network path X:\MPPFiles\sample.mpp, you will create the 
Virtual Folder MPPFiles in /HPVWeb/Files/Mpp/ folder). Open Internet Explorer (or other 
compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=/MPPFiles/sample.mpp&filteresourcename=JohnS
mith. 

or 
 If the file you wish to view is situated on another Internet server (i.e. 

http://www.myserver.com/files/sample.mpp) you are still able to view this file directly by 
opening Internet Explorer (or other compatible browser) and type the address: 
http://localhost/HPVWeb/Views.aspx?mppfile=http://www.myserver.com/files/sample.mpp&filter
resourcename=JohnSmith. 

 
 
ODBC Method: If you have mpp files saved in a repository database (MS SQL Server, Access etc...) you 
must first create a DSN to the respective database. You may access it from HPV Web Server by selecting 
File/Open via ODBC in the menu or clicking Open via ODBC button in the toolbar, select your newly 
created DSN, provide user name and password if required by the system and select the project you want 
to load from the list. You may also configure from the Administration page the DSNs that should be 
available to the users. 
 
MPP Folders Link Method: If you already have folders where you have placed mpp files, then you 
should use this method to allow the users to access the mpps without being necessary to upload them 
first. To use Server Link, you need first to configure in Administrator page the folders you want to share to 
your users. Then, select File/MPP Folders Link in the menu or click the MPP Folders Link button in the 
toolbar to display an Explorer like form which you may browse and select the mpp file you want to open.  
 
Open MS Project Server: HPV Web is able to connect to a Microsoft Project Central Database, retrieve 
the list of projects and then open the selected ones. You must first configure the MSP Central settings 
through the Collaboration Options, then you may access the MSP Central database by selecting File/Open 
MS Project Server in the menu or by clicking Open MS Project Server button in the toolbar. The projects 
available to users are set up through the Microsoft Project Central Administration page. Notice that MS 
Project Server requires authentication (either Project Central Auth or NT Auth) and you must provide a 
valid user name and password to gain access to the projects list. To use the NT Auth method, you must 
disable the Anonymous Login and enable Windows Integrated Login from IIS for the HPV Web/Server 
application.  
 
 



 

How to integrate with Share Point 

 
HPV Web/Server 2007 SP2 ships with a Share Point HPVWebPart.dwp file that 
allows the users to view MS Project files from Share Point websites without any 
software installed on their PCs. 
 
 
Bellow you will find the detailed configuration steps to get your Share Point website integrated 
with the HPV Web Server 2007 SP2 product. 
 
Prerequisites 
- Windows Server (2000 or 2003) with Share Point Services configured (WSS 2.0) 
- NT User with Share Point ”r;Reader” Rights 
 
Configuration Steps 
Step 1: 
Download HPV Web/Server 2007 SP2 from our website, run setup and follow default instructions steps. 
Enter the NT Share Point user name and password when asked by the installation wizard. 
 
Step 2: 
After HPV Web/Server 2007 SP2 was installed successfully go to your Share Point website’s ”r;Site 
Administration” and select ”r;Manage Web Part gallery”. 
 
Step 3: 
Select ”r;Upload Web Part” 
 
Step 4: 
Select ”r;Browse” and point to ”r;C:\ Program Files\ Viewer Central Inc\ HPV Web 
Server 2007 SP2\ SharePoint \HPVWebPart.dwp” (or the appropriate path)   
 
Step 5: 
Select ”r;Save and Close” 
 
Step 6: 
The HPVWebPart.dwp shows under the Web Part Gallery. Click on home and navigate to your document 
library web part page 
 
Step 7: 
Select ”r;Modify Shared Page/ Add Web Parts/ Browse” 
 
Step 8: 
Drag and Drop ”r;HPVWebPart” on your MS Project Doc Library 
 
Step 9: 
The HPVWebPart should be successfully configured at this point. Expand the drop down menu and select 
Open with HPV Web Viewer. 
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Fig. Share Point integration 
 
Troubleshooting Tips 
• Web.Config 
Locate the folder where the HPV Web/Server 2007 SP2 is installed (i.e. C:\ Program Files\ Viewer Central 
Inc\ HPV Web Server 2007  SP2\ ) and open Web.Config file in any text editor. Make sure the tag 
<identity> shows like bellow 
<identity impersonate="true" userName="NTSharepointUser" password="Password" /> 
 
• IIS Security 
Open Internet Information Services (IIS) Manager, Right click on the HPVWeb Web Site and select 
Properties; 
Switch to Directory Security Tab and make sure that both Enable anonymous access and Integrated 
Windows authentication are both checked. 
 
• Pop-up Blockers 
Make sure all your pop-up blockers are turned off for the HPV website. 
 
For additional help check the HPV Web/Server 2007 SP2 Product Guide or our support website at 
www.projectviewercentral.com 



 

How to print or email using HPV Web/Server 

In HPV Web/Server 2007 SP2 application you are not only able to view MPP 
files, but you are also able to print or email them to your partners, business 
associates etc... Printing and emailing are easy to use and intuitive features. Two 
options are available: 
 

Print 
Send by email as PDF 

 
Print will print as PDF in a high quality and portable format preferred by most users as a powerful tool of 
printing files. Our product comes with a built in PDF writer engine. Send by email enables you to send the 
current view to other members of your team as a PDF file, which they can view, print, etc... 
 
In order to print the current view, click on the corresponding icons in the toolbar or select Print from the 
File menu. You can customize the page options through the page setup form (File/Page Setup) or verify 
the printed document through the print preview form (File/Print Preview). After clicking on Print button, a 
PDF file will be generated that you can use to print or distribute. 
 
In order to send by email the current view, click on the corresponding icon in the toolbar or select Send by 
email in File menu.  The PDF file will be generated using the current page options defined in Page Setup 
form and a prompt window will be displayed where you can type the email address where you want the 
email to be sent.  
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File 

Open 
HPV Web/Server opens Microsoft Project files ’98, Microsoft Project files 2000, 
Microsoft Project files 2002, Microsoft Project files 2003 and Microsoft Project files 
2007. In order to open a MPP file, you must perform the following steps: 
 

1. Select File/Open in Main Menu or click on Open icon in toolbar; 
2. In the pop-up window that is displayed, browse for the location of the 

MPP file you want to view; 
3. Select the MPP file you want to view; 
4. Click on View project button; 
5. The project file is opened with HPV Web/Server. 

 
Except the standard way of viewing a file (through File/Open), HPV Web/Server provides alternative 
methods of viewing the project files, that you can find here. 
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Open via ODBC 
HPV Web/Server allows to open and view MPP files saved in a repository 
database (MS SQL Server, Access etc...). You may access the MPP files by 
performing the following steps: 
 

1. Create a DSN to the database that contains the MS Projects; 
2. Select File/Open via ODBC in the menu or click on the ODBC button in 

toolbar; 
3. In ODBC Data Source Administrator form, select the DSN that points to your project database 

and click on OK button; 
4. If the database requires authentication, provide a valid user name and password for the DSN; 
5. In the Choose project form, select the project you want to view and click on Open button. 
6. The project is opened with HPV Web Server. 
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File 

Open MS Project Server 
HPV Web/Server is able to connect to a Microsoft Project Central Database, 
retrieve the list of projects and then open the selected ones. You must first 
configure the MSP Central settings through the Collaboration Options tab, then 
you may access the MSP Central database by selecting File/Open MS Project 
Server in the menu or by clicking the Open MS Project Server button in the

bar.  

lect the 
project you want to view and click on Open. The project file will be opened with HPV Web/Server. 

 
tool
 
After selecting File/Open MS Project Server, HPV Web/Server will try to establish a communication with 
MS Project Server based on the logon information provided in Collaboration tab. Once the connection is 
established, a list of projects available on Microsoft Project Central Server will be displayed. Se
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MPP Folders Link 
HPV Web/Server allows quick access to MPP files stored in special folders, 
without being necessary to upload them. To gain access to the respective MPP 
files, you must perform the following steps: 
 

1. Select File/MPP Folders Link in Main Menu or click on the "MPP Folders 
Link" button in toolbar; 

2. Navigate in MPP Folders Link form (similar to Windows Explorer) and select the MPP file you want 
to open then click on Open button; 

3. The project file is opened in HPV Web/Server. 
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Send by e-mail 
HPV Web/Server enables you to send by email the current view to other 
members of your team as a PDF file, which they can view, print, etc... In order to 
send by email the active view, you must perform the following steps: 
 
1. Select File/Send by email or click on Send by email button in toolbar; 
2. Type the email address where you want the file to be sent in the prompt 
window that is displayed; 
3. Click on Send button; 
4. The PDF file will be generated containing the current page information that is displayed in the 
application, together with the sort, filter and zoom selections that were applied and the application will 
send it to the specified email address. 
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Page Setup 
The Page Setup functionality is available in the Main Menu (File/Page Setup) and 
in Toolbar, the Page Setup icon. The page setup helps you define the printin
settings: 

g 

 
Page Scaling 
Adjust to - the user can set the ratio aspect to which the printing should be 
performed;  
Fit to - formats the MPP file content to fit to the specified number of pages.  
Note: The paper size is calculated automatically. Adjust to and Fit to options are not available for 
Calendar, Task Usage and Resource Usage Views. 
 
Margins 
Helps you to specify the margins' width. 
 
Legend 
Every page: the legend will appear on every printed page; 
Legend page: the legend will be printed on a separately page; 
None: the legend will not be printed. 
 
View 
Print all sheet columns: Click the check box to print all sheet columns in the view. 
Print first "n" columns on each page: Use this option to print predefined columns on each page.  
Print Notes: Click the check box in order to print the notes. The notes will be printed at the end of the 
document. Note: This feature is available for Gantt Chart, Tracking Gantt, Task Sheet and Resource Sheet 
views. 
Print blank pages: check or uncheck this option to print or not the blank pages. 
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File 

Print Preview 
The Print Preview functionality is available in two modes: Main Menu (File/Print 
Preview) or Toolbar, the Print Preview icon. When you click the Print Preview 
option a new window appears and the application generates the pages to be 
printed. The pages display the information in the exact format you set in the 
application: i.e. hidden columns, added columns, resized columns, resized panels 
etc. The pages follow the settings selected at Page Setup (paper size, margins, 
orientation).  
 
The Print Preview window has a dedicated Menu: 
 
Page left/Page right: view the pages from left to right; 
Page up/Page down: view the pages from top to bottom; 
Zoom icon: you can magnify or diminish the page content; 
One page icon: displays a page to fit on the screen; 
Multiple pages icon: displays multiple pages to fit on the screen; 
Print button: sends the pages content to the printer; 
Page Setup button: you can customize the appearance of the printed pages; 
Close button: closes the Print Preview and returns to the main project viewer. 
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Print 
The Print functionality is available in two modes: Main Menu (File/Print) or 
Toolbar, the Print icon. By using this functionality the user can send the file 
content directly to the printer as a pdf file. Our product comes with a built in PDF 
writer engine. Print opens a dialog form for printing the current view. 

ter.  

 
Properties: opens a dialog window in which you can set printer options. This 
page is specific to each prin
Print range: sets the number of pages to be printed. 
Copies: sets the number of copies to be printed. 
Timescale: All - displays the entire project timespan / Dates - displays information only for the specified 
data range. Note: This option is not available for Network Diagram and Resource Sheet views. 
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uickly. 

Log Off 
The Log Off functionality is available from the Main Menu (File/Log Off) or from 
the upper right corner link and it closes the current working session for the 
current user. This is mainly important to free up licenses more q





 

Edit 

Go To  
Go To option is located in the Main Menu (Edit/Go To) and you may use it in order 
to go to specified item.  
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Find 
Find option can be accessed either from the Main Menu (Edit/Find) or by clicking 
the Find icon in toolbar. 
Enter the word you want to find in the document (you may specify the field you 
want to be searched, apply different constraints to the search or specify search 
direction), then click Find Next button.  



 

View 

Views 
The View Menu opens all the available views in this application:  
 

o Gantt Chart  
o Tracking Gantt  
o Network Diagram  
o Resource Sheet  

o Resource Graph  
o Task Usage  
o Resource Usage 
o More views 
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Views 
Calendar 

Description: The Calendar is the view that presents the tasks in a graphical 
manner on a day to day map. With blue bars for common tasks and black bars for 
milestones, tasks show their span over days or weeks. 
 

 
 
Fig. Calendar 
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View 

Gantt Chart 

Description:   The Gantt Chart view displays task information in two panels: The 
left panel displays information as a sheet and the right panel displays information 
as a chart (Fig. 2.1). Panel 1 displays the task information as a sheet and includes 
details about start and finish task dates, resources assigned to them or % 
complete. The following columns are usually referred: Id, Indicators, Name, 
Duration, Start, Finish, Resource Names, Percent Complete, Predecessors. Panel 2 
displays the Gantt bar representation of the tasks. The bar's length and position on the timescale indicate 
when that task begins and ends. In addition, the position of one task bar in relation to another indicates 
whether the tasks follow one another or overlap.  
 
Legend: The Gantt chart displays blue bars for common Tasks, black rhombuses for Milestones, blue bars 
connected with suspension dots for Task Splits, black bars for Summary Tasks. The background displays 
the Project’s calendar time span. 
 
Deadlines: A deadline indicates the target date when the user wants a task to be completed. The 
deadline is displayed in Gantt chart as a green arrow. 
 
Links: The Gantt panel display links that show the predecessor or the successor relation between tasks. 
 
Bar Texts: A various project information (such as duration, constraint type, finish etc) can be used for the 
bar texts in order to describe a task. The position of the bar texts can be: left, right, top, bottom and 
inside.  
 

 
 
Fig. Gantt Chart 
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Network Diagram 

Description: The Network Diagram View displays the tasks and task 
dependencies as a flowchart. Tasks are shown in geometrical blocks along with 
their Start, Finish, Duration and Complete Percent information (where available). 
Task dependencies are displayed with connecting arrows between the Task blocks. 
Red border suggests a critical task.  
   
Shapes legend: 
· Parallelogram block: summary task 
· Rhombus block: milestone 
· Rectangle block: common task 
· Block with no diagonal: unstarted task 
· Block with one diagonal: task in progress 
· Block with cross diagonals: finished task 
· The arrows drawn between the task blocks show the precedence relations. 
 

 
 
Fig. Network Diagram 
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View 

Task Usage 

Description: The Task Usage View is a matrix of work assignments. In a table 
spanned over the Project’s period, work loads are presented for each Task, and 
within it, each Resource, if any is available. 
 

 
 
Fig. Task Usage 
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Tracking Gantt 

Description:   The Tracking Chart view displays task information in two panels: 
The left panel displays information as a sheet and the right panel displays 
information as a chart (Fig. 3.1). Panel 1 displays the task information as a sheet 
and includes details about start and finish task dates, resources assigned to them 
or % complete. The following fixed columns are referred: Id, Indicators (only Task 
Notes available), Name, Duration, Start, Finish, Resource Names, Percent 
Complete, Predecessors. Panel 2 displays the Gantt bar representation of the tasks. The bar's length and 
position on the timescale indicate when that task begins and ends. In addition, the position of one task 
bar in relation to another indicates whether the tasks follow one another or overlap.  
 
Tracking Gantt View integrates the Gantt Chart features. In addition, it also displays the critical path and 
the baseline information. In Tracking Gantt View, tasks are represented using 2 bars displayed one on top 
of the other. If no baseline is saved only one bar is shown. The lower bar shows baseline start and finish 
dates, and the upper bar shows scheduled start and finish dates. If baseline start and finish dates are the 
same with scheduled start and finish dates then the bars are identical in size and position. If they are 
different then the bars will appear slipped from one another, the initial and final positions being delayed 
with the difference from the Scheduled Start Date and Baseline Start Date, respectively with the difference 
from the Scheduled Finish Date and Baseline Finish Date. 
 
Legend: The Tracking Gantt view displays blue bars for common Tasks, black rhombuses for Milestones, 
blue bars connected with suspension dots for Task Splits, black bars for Summary Tasks. A common task 
may be shown both in light and dark blue. The light blue color suggests the incomplete percentage of 
work; the dark blue color suggests the completed percentage. Red task bars identify the critical tasks. A 
critical task may be shown using both red-border, no fill color cells (showing the completed percentage) 
and red-fill cells (showing the uncompleted percentage) The background displays the Project’s calendar 
time span. Panel 2 also shows the last saved baseline. Baseline information is designed with gray bars in 
the Gantt Chart, below each referred task. 
 
Deadlines: A deadline indicates the target date when the user wants a task to be completed. The 
deadline is displayed in Gantt chart as a green arrow. 
 
Links: The Gantt panel display links that show the predecessor or the successor relation between tasks. 
 

 
 
Fig. Tracking Gantt 
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View 

Resource Graph 

Description: The Resource Graph View displays the resource allocation 
information. Resources are displayed in a list. For each of them a 2D-barchart is 
shown (0x-time units, 0y-work load). The bars are colored part in blue for the 
work span within normal capacities of that resource and part in red for the over 
allocated work assignments. 
 

 
 
Fig. Resource Graph 
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Resource Sheet 

Description: The Resource Sheet view displays resource information in a sheet 
format. You can review information about each resource: Name, Type, material 
label, Initials, Group, Max. Units, Std. Rate, Ovt. Rate, Cost/Use, Accrue At, Code. 
 
Legend: Over allocated resources are shown in red color.  
 

 
 
Fig. Resource Sheet 
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View 

Resource Usage 

Description: The Resource Usage View is a matrix of work assignments. In a 
table spanned over the Project’s period, work loads are presented for each 
Resource, and within it, each Task if any is available. This view is another side of 
the same aspect presented by Task usage. 
 
Tip: Clicking on a resource or assignments in Resource Usage list (left panel) will 
jump to the corresponding position in the calendar (right panel). 
 

 
 
Fig. Resource Usage 
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More Views 
On the View menu, click the view you want to use. To use a view that is not on the View menu, click More 
Views, click the view you want to use in the Views list, and then click Apply. 
 

More Views: 
o Bar Rollup 
o Descriptive Network Diagram 
o Detail Gantt 
o Leveling Gantt  
o Milestone Dates Rollup 
o Milestone Rollup 
o Multiple Baselines Gantt 
o Task Sheet 

 
 Custom Views: HPV Web/Server provides the possibility to view the custom views as they were 
created/modified and saved in MS Project (including tables, inserted/hidden columns, text styles, bar 
format, zoom, filter, sort, etc..).  
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View 

Table 
HPV Web/Server provides a set of tables used to show specific information 
about tasks, resources, and assignments in a sheet view.  To apply a table to the 
view, point to Table on the View menu and then select the table you want to 
apply. There are two types of tables: task tables (which are applied to task type 
views) and resource tables (which are applied to resource type views). To use a 
table that is not on the menu, click on More Tables, select the table you want to 
use from the list of available tables and then click on Apply. 
 

Task Tables Resource Tables 

o Baseline o Cost 
o Constraint Dates o Earned Value 
o Cost o Entry - Material Resources 
o Delay o Entry - Work Resources  
o Earned Value o Entry  
o Earned Value Cost Indicators o Export  
o Earned Value Schedule Indicators o Hyperlink 
o Entry o Summary  
o Export o Usage  
o Hyperlink o Work 
o Rollup  
o Schedule  
o Summary  
o Tracking 
o Usage  
o Variance  
o Work 
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Reports 
General 

Reports are available from the Main Menu, View/Reports option and they are used 
to show various Project situations.  
 
Reports are split into 2 categories: 

o Overview  
o Current Activities 
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View 

Overview Reports 

This section displays information regarding the entire Project duration such as: 
Top Level tasks. 
 

1. Project Summary - This report presents a resume of the entire project. 
2. Top Level Tasks - This report displays a list with task information for 

tasks that are outlined at level 1 in the Project. 
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Current Activities Reports 

This section displays information regarding task information such as: Unstarted 
tasks, Tasks in Progress, Completed Tasks. 
 

1. Unstarted tasks - Displays a list with task information for tasks that are 
0% complete (have no actual start date saved).  

2. Tasks in Progress - Displays a list with task information for tasks that 
have the % complete value between 1 and 99 (have an actual start date but no actual end date 
saved). 

3. Completed tasks - Displays a list with task information for tasks that are 100% complete (have 
both actual start and finish dates saved). 
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r).  

Zoom 
Zoom is available by selecting View -> Zoom from the main menu or by clicking 
on the (-) or (+) buttons in the toolbar. The Zoom engine currently implements 
four levels of details: One week level (the visible unit is one week); Two weeks 
level (the visible unit is a two weeks pack); One month level (the visible unit is 
one month); One year level (the visible unit is one yea
 
Every time a view is selected the view displays the chart information according to the last zoom selection 
(the default if none). 
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Insert 

Insert Column 
Insert Columns functionality can be accessed by clicking the Columns Icon in the 
toolbar or via the Insert Menu. This feature is available for Gantt Chart, Task 
Sheet and Resource Sheet type views. Insert the columns you want to appear in 
the view by selecting them in  Field name combo-box. You may also change the 
columns order, alignment or 
 
You can also insert/hide columns by right-clicking on the header of the columns in the task sheet and 
select Insert or Hide Column option from the contextual menu.  
 
The columns width can be adjusted manually by dragging with the mouse, to left (in order to minimize the 
width) or right (to enlarge it) the margins of the headers in the task sheet. All the changes made in the 
task sheet related to the inserted or hidden columns, width, title alignment, etc. will be reflected in the 
printed page.  





 

Format 

Timescale 
Format Timescale option is available in Gantt Chart type views. The Timescale 
helps the user to customize the layout of the chart panel. 
 
Tier formatting: Middle - refers to the first row delimiting dates in the chart 
panel. It can be used to change the display to Units like 
Days/Weeks/Months/Years.  
Tier formatting: Bottom - refers to the second row delimiting dates in the chart panel. It can be used to 
change the display to Units like Days/Weeks/Months/Years. 
 
Note: The time unit used in the Top row must be larger than the time unit used in the Bottom row. 
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Indicators 
The Indicators field is located to the right of the ID field and give different types of 
information about a task or resource. HPV Web/Server supports the following 
indicators: 
 

The task, resource, or assignment has a note attached to it.  
The task, resource, or assignment has a hyperlink associated with it.  
The task finishes on a date that is later than its deadline. If the deadline date passes and the 
task is not completed, an indicator date will be displayed. 

 

The task has an inflexible constraint. Inflexible constraints include Must Finish On (for projects 
scheduled from the start date) and Must Start On (for all projects).  

 

The task has a moderately flexible constraint. Flexible constraints are As Soon As Possible, As 
Late As Possible, Finish No Earlier Than, Finish No Later Than, Start No Earlier Than, and Start 
No Later Than.  

 

The task has not been scheduled or completed within the constraint's time frame.  
The task is complete.  
The task is an inserted project (also called a subproject). The inserted project appears as a 
summary task in the master project.) 

 

 



 

Tools 

Options 
 
View 
 
On the Tools menu, click Options, go to tab View and then change the setting you 
want: 
 
Date Format: change the date format in all the views of the application by choosing from a list of available 
formats.  
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Appearance 
This menu option allows to choose one of the 4 styles available in the current 
version of the application: Standard, XP Blue, XP Green and XP Silver. When 
choosing a style, the application will be refreshed and the new theme will be 
applied.  
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Select Language 
You may change the active language of the application by selecting a language in 
the combo box (Select Language menu) and then click OK. HPV Web/Server is 
currently available in the following languages: English, French, German, Spanish, 
Italian and Japanese. If you wish to add new languages for your new multinational 
company, contact the sale department for further information at: 
sales@projectviewercentral.com 





 

Project 

Sort 
The sort option may be accessed via the main menu from Project -> Sort or from 
the toolbar by clicking on the Sort Icon. Sort has 5 shortcuts (Sort by Start Date, 
by Finish Date, by Priority, by Cost and by ID) and one form where you may 
choose three sorting criteria each of it Ascending or Descending.  
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Filters 
Filter option can be accessed in two modes: Main Menu (Project/Filter) and 
Toolbar, the Filter icon. The filter option allows the user to view a particular type 
of information in the project by displaying only the information the user is 
interested in and hiding the rest. If there are no filters to apply, then all the items 
will be taken into consideration. 
 
Custom Filters: HPV Web/Server application provides all standard filters but also custom filters as they 
were defined and saved in MS Project for a particular file. If any of the standard or custom filters you want 
to use is not in the Project/Filtered for list, go to Project/Filtered for/More Filters and select it from the list 
of available filters. 
 
Highlight Filters: You can view the filtered information as highlight text by setting the filter as highlight 
filter. In order to highlight a filter, go to Project/Filtered for/More Filters, select a filter in the list of 
available filters and then click on Highlight button. The tasks or resources that meet the filter’s criteria will 
be displayed as highlight (blue) text in the view. 
 
Task Filters: allow the user to view specific aspects of tasks. This option is available for Gantt Chart, 
Network Diagram, Task Usage and Tracking Gantt views. 
 

All tasks 

All tasks will be displayed, regardless of their particularities. 

Completed Tasks 

This filter shows all tasks that are finished. 

Cost Greater Then... (interactive filter) 

This filter shows tasks whose cost is greater then a specified amount. 

Cost Overbudget 

This filter shows all tasks with a cost greater than the baseline cost. 

Created After... (interactive filter) 

This filter shows all tasks created after a specified date. 

Critical 

This filter shows all tasks that are on a critical path. 

Date Range... (interactive filter) 

This filter shows all tasks that start or finish after the earlier specified date and before the later 

specified date. 

Incomplete Tasks 

This filters shows all tasks that are not completed. 

In progress tasks 

This filter shows all tasks that are started but not completed yet. 
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Late/Overbudget tasks assigned to... (interactive filter) 

This filter shows all tasks assigned to a specified resource that are exceeding the budget or 

finishing after the finish date in the baseline plan. 

Linked fields 

This filter shows the tasks to which information from other programs has been linked. 

Milestones 

This filter shows only the tasks that are milestones. 

Resource Group... (interactive filter) 

This filter shows the tasks allocated to the resources belonging to a specified group. 

Should start by... (interactive filter) 

This filter shows all tasks that should have started by a selected date but they haven't. 

Should start/finish by... (interactive filter) 

This filter shows all tasks that haven’t started or finished within a specified date range. 

Slipped/Late Progress 

This filter displays tasks that have slipped behind their schedule finish date or haven’t been 

progressing as scheduled. 

Slipping Tasks 

This filter shows all tasks that are behind schedule. 

Summary 

This filter shows all tasks that have subtasks.  

Task Range... (interactive filter) 

This filter shows all tasks that have ID numbers within the specified range. 

Tasks with a Task Calendar assigned 

This filter shows all tasks to which a task calendar was applied. 

Tasks with Attachments 

This filter shows all tasks to which a note or object was attached. 

Tasks with Deadlines 

This filter shows all tasks to which a deadline was specified. 

Tasks with Estimated Durations 

This filter shows all tasks whose duration is estimated. 
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Tasks with Fixed Dates 

This filter shows all tasks that have an actual start date. 

Tasks/Assignments with Overtime 

This filter shows all tasks or assignments that are specified as overtime work. 

Top Level Tasks 

This filter shows the highest-level summary tasks. 

Unstarted Tasks 

This filter shows tasks that haven't started. 

Using Resource in Date Range... (interactive filter) 

This filter shows the tasks allocated to a specified resource within a specified date range. 

Using Resource... (interactive filter) 

This filter shows all tasks that use the specified resource. 

Work Overbudget 

This filter shows all tasks whose scheduled work is greater then the baseline work. 

 
Resource Filters: allow the user to view specific aspects of resources. This option is available for 
Resource Graph, Resource Sheet and Resource Usage views. 
 

All Resources 

All resources will be displayed, regardless of their particularities. 

Cost Greater then... (interactive filter) 

This filter shows all resources whose cost is greater then a specified amount. 

Cost Overbudget 

This filter shows all resources whose scheduled cost is greater then the baseline cost. 

Date Range... (interactive filter) 

This filter shows all tasks and resources with assignments that start or finish within the specified 

date range. 

Group... (interactive filter) 

This filter shows all resources belonging to a specified group. 
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In Progress Assignments 

This filter shows the assignments that have been started but not yet completed. 

Linked fields 

This filter shows the resources to which information from other programs has been linked. 

Overallocated Resources 

This filter shows all resources that are overallocated. 

Overbudget Resources 

This filter shows all resources with a scheduled cost greater than the baseline cost. 

Resource Range... (interactive filter) 

This filter shows all resources that have ID numbers within the specified range. 

Resource - Material 

This filter shows the material resources. 

Resource - Work 

This filter shows work resources. 

Resources with Attachments 

This filter shows the resources to which a note or object has been attached. 

Resources/Assignments with Overtime 

This filter shows the resources or assignments that are specified as working overtime. 

Should start by... (interactive filter) 

This filter shows all tasks or assignments that should have started by a specified date but haven't. 

Should start/finish by... (interactive filter) 

This filter shows all tasks that haven’t started or finished within a specified date range. 
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Slipped/Late Progress 

This filter displays tasks or assignments that have slipped behind their schedule finish date or 

haven’t been progressing as scheduled. 

Slipping Assignments 

This filter shows all assignments that have slipped from their original baseline plan. 

Unstarted Assignments 

This filter shows all assignments that haven’t yet started. 

Work Complete 

This filter shows resources that have completed all of their assigned tasks. 

Work Incomplete 

This filter shows all resources with scheduled work less than the baseline work. 

Work Overbudget 

This filter shows all resources whose scheduled work is greater than the baseline work. 
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Show outline level 
This option can be accessed via the menu bar (Project/Show) or in the toolbar and 
displays the tasks for the specified level. 
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Project Information 
The Project Information window is available from the Main Menu, Project / 
Information. The Project Information window presents general information about 
the Project such as: Start and Finish dates of the Project, Current Date is the 
current date read from the server where the application is hosted, Status date 
shows the date against which earned value calculations are performed, Calendar 
specifies the Project’s Calendar type and Priority indicates how readily are the 
resources from this project when competing on multiple projects.  
Note: Project’s Priority overrides Task’s Priority. 



 

Collaborate 

Collaboration Options 
 
On the Tools menu, click Options, go to tab Collaborate and then change the 
setting you want: 
 
Collaborate:  
Collaborate using: - Specifies whether you are using Project Central Server or 
not. 
Project Server URL and Test Connection button - Use this section to specify the URL for Project Central 
and check whether the connection to Project Server is working properly. 
 
Identification for Project Server: Use this section to set up the authentication method with Microsoft 
Project Central Server.  
 
Windows User Account - Uses current user’s credentials to authenticate with Microsoft Project Central. 
Once the user selects this type of authentication, username and password fields will be disabled as the 
application uses the current logon credentials. 
Microsoft Office Project Username - Uses the entered username and password to authenticate with MS 
Project Central. Once the user selects this type of authentication, he must fill in the username and 
password fields, which are mandatory. 
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Help 

About HPV 
The About HPV option is available from the Main Menu and provides the current 
version series and additional copyright information. 
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les. 

Register 
You may use this form to register the application. If you have the trial version and 
you purchase the application you will receive a license key. You may use the text 
box to enter the received key and then press the Accept button. After that you 
may close the form by using the "close this window" link and continue viewing 
MPP fi
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